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Chapter 1: Getting Started with 
CyberQuake 

To use this software you must be familiar with either 
Windows 98, NT, 2000  or XP. You should refer to 
Microsoft Windows User's Guide for learning how to 
use these Windows operating instructions. To install 
CyberQuake, refer to the Installation guide. 

Even though this software has been designed to be an 
easy-to-use tool for beginners, a minimum knowledge 
in Earthquake Engineering is required for an adequate 
use of it. 

Two versions are available: 

1. Engineering Analysis version. 

2. Advanced Engineering Analysis version. 

The second version covers the first one from the point 
of view of functionality and includes additional 
capabilities. To facilitate the use of the software, both 
versions are presented in the same environment. 
However, some commands are not enabled in the 
Engineering Analysis version. 

Note: For each of the above versions, an Education 
version is also available. 

All commands are accessed from a drop-down menu 
bar and toolbars are available for experienced users. 

To choose a command: 

1. with the mouse: 

 - double click on the name of the command in the 
drop-down menu. 
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2. from the keyboard: 

 - either press ALT followed by an underlined letter 
of the command name, 

 - or press ALT to select the menu bar and use the 
arrow keys to move to the command and then 
press ENTER. 

Two classes of operations may be performed by this 
software: 

- basic operations on accelerograms (or any other 
curves) by using Tools, 

- Soil Dynamic Analysis. 

 

For practical purposes, several natural recordings are 
integrated in the Cyber Database available via the 
Import Accelerogram command in the File drop-down 
menu in any frame, i.e. Main Frame, Soil Column 
Frame, Equivalent Linear Frame and Control Point 
Frame. 

 

To get familiar with the different frames, see sections 
dedicated to: 

- Main Frame, 

- Soil Column Frame, 

- Equivalent Linear Frame, 

- Control Point Frame. 

User's own database of accelerograms may be also 
accessed to. They should be transformed into Cyber 
Formats by users out of the software or in it by using 
Convert Format in Operations on Curves from Tools 
menu commands. 

The Tools menu commands are also available in all 
frames. 
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We advise users to start with simple seismic signals 
such as a Ricker Wavelet as Input Motion in order to 
get familiar with the software. It is also recommended 
to begin with an elastic behavior assumption for soil. 

The dynamic analysis of multilayer soil needs the 
definition of: 

- the underground geology (geometry), 

- the (hydro)mechanical properties, 

- the input motion and associated information. 

The computed results may then be visualized, stored 
and analyzed as other created or imported curves by 
using Tools. 

The underground geology is introduced easily in the 
Soil Column Frame, the Equivalent Linear Frame or the 
Control Point Frame, depending on the type of analysis 
to be performed. 

The layers are arranged from top to bottom by adding 
lines in a table-type structure. To add, insert, delete, 
copy or paste layers, use commands in the Edit menu 
from the menu bar in each frame. 

The (hydro)mechanical properties associated with each 
layer are also introduced in the same structure. The 
Define menu from the menu bar and its drop-down 
menu of commands complete the definition of the 
problem. 

To perform an analysis: 

1. Open either a Soil Column Frame, an Equivalent 
Linear Frame or a Control Point Frame. 

2. Enter the soil layers and their (hydro)mechanical 
properties. 
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3. In transient analyses, in the Soil Column Frame, 
the nonlinear constitutive behavior may be 
assumed. 

4. Enter the input motion.1

5. Enter the time history. 

6. Start analysis. 

Note: operations 2 to 5 may be performed in any order. 

Use the checklist command in the Computing menu 
from the menu bar, to verify that all data required for 
the analysis have been entered. 

 

Engineering Analysis 
The Engineering Analysis version includes the 
commonly admitted hypotheses in practice of Soil 
Dynamics and Earthquake Engineering: 

1. One of the horizontal components of the input 
acceleration is considered. 

2. Input motion is assumed to be vertically incident. 

3. Either elastic or equivalent linear (viscoelastic) 
behavior is adopted for the soil layer. 

4. One-phase analysis is carried out. 

However, new features used by expert engineers are 
introduced, they are: 

1. Vertical components of the Input Motion is also 
introduced; i.e. two-dimensional kinematics. 

                                                 

 
1  The input motion may be an analytical curve, an imported 

natural accelerogram or an accelerogram obtained after 
deconvolution. 
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2. Nonlinear (elastoplastic) behavior of soil layers 
may be considered. 
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3. The totally undrained2 condition is included. 

4. The bedrock may be either Rigid3 or Deformable4. 

5. The whole configuration may have a slope (for rigid 
bedrock only). 

                                                 

 
2 The totally undrained condition assumes no volumetric strain in 

the layer. In one-dimensional geometry the vertical strain is 
prevented. With elastoplastic assumption for the soil layer this 
will result is pore-pressure generation if the material is 
contracting (e.g. loose sand) and the liquefaction may occur. In 
this case the computation assuming a one-phase material with 
an additional constitutive relation representing the 
incompressibility. In the Engineering Analysis version the soil 
layer under the water table may be only modeled as an 
undrained material.  

3 A rigid bedrock represents an ideal medium with very strong 
mechanical characteristics compared to overlying multilayer soil 
structure. 

4 A deformable bedrock is modeled as a semi-infinite isotropic 
homogeneous elastic linear medium. It is characterized by the 
shear and compression body wave velocities and its mass 
density. 
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Note: 
1. The vertical component of input acceleration is 
introduced with elastic and elastoplastic assumption for 
the soil layers (not for the equivalent linear approach). 
2. The totally undrained condition corresponds to zero-
permeability of materials during the seismic event. This 
hypothesis is very often verified in natural conditions. 
The pore-pressure time history is evaluated knowing 
the amount of irreversible volumetric plastic strain. The 
liquefaction of one or more soil layers may occur 
depending on their mechanical properties and more 
specifically with respect to their degree of compaction. 
Additionally, the total irreversible settlement at the 
ground surface, after the dissipation of pore-pressure 
generated during the earthquake, is furnished. 
3. If the contrast between the velocity in the bedrock 
and the neighboring soil layer is high, the bedrock may 
be considered as rigid. This assumption has 
computational advantages. 
4. The bedrock is always assumed to have the same 
slope as the soil layer. Hence, the effect of lateral 
heterogeneity (two and three-dimensional effects) are 
not considered. 

Advanced Engineering Analysis 
The Advanced Engineering Analysis version has 
several extra options compared to the other version. 

The major features of this version are: 

1. Three-dimensional kinematics. 

2. Real two-phase computations. 

All capabilities of the Engineering Analysis version are 
included in this version and, as both versions are 
presented in the same environment, it is easy to switch 
from one to another. 
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Education versions 
This software may be used for educational purposes. It 
is suitable for Civil and Earthquake Engineering or 
Seismology teaching programs. 

The Education versions may not be used in 
professional studies. 

Soil Layer 
The term of soil layer is associated with a physical soil 
layer characterized by its thickness and 
(hydro)mechanical properties. The elastic behavior of 
the layer is defined by the mass density and 
compression and shear wave velocities. Hence, linear 
elasticity is assumed. If the elastic properties vary with 
depth, one should subdivide the soil layer into several 
layers and introduce the appropriate velocities. 

In the Soil Column Frame where Cyber (transient) 
Analysis is carried out, the soil layer may be assumed 
as either elastic or elastoplastic. The elastoplastic layer 
is considered as being either a sand, a clay or a gravel. 
These materials are taken into account by using the 
Cyber Constitutive Model. Default parameters are 
furnished for each type of these materials. One should 
verify whether the proposed parameters are 
appropriate or not by simulating the cyclic and 
monotonous tests, by using G-γ and D-γ curves and/or 
Simulator. 

In the Equivalent Linear Frame and Control Point 
Frame, an equivalent linear analysis is carried out. The 
curves containing G/Gmax-γ and D-γ data are 
necessary for such analyses, when the soil layer 
material is set to Inelastic. These curves may be either 
experimental curves or those obtained from a 
numerical simulation for instance from a cyclic test in 
the Soil Column Frame. For a linear elastic analysis, no 
curves are required, when the soil layer material is set 
to Elastic. 
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Bedrock 
Here, the bedrock represents the semi-infinite layer 
beneath the soil or the rock profile to be studied. 

It is either considered as Rigid or Deformable 
depending on its mechanical characteristics; i.e. wave 
velocities. 

For high contrast in velocities of the bedrock and the 
adjacent layer (e.g. 20 or more), it is recommended to 
use rigid option for numerical efficiency. 

In all versions of CyberQuake, when using the Soil 
Column Frame and Equivalent Linear Frame, the Input 
Motion is considered to be defined at the outcropping 
bedrock which is itself a homogeneous, isotropic linear 
elastic material. 

However, it is possible to define a Control Point on the 
surface of a multilayer viscoelastic rock. It is then 
possible to deconvoluate the Input Motion to the 
outcropping bedrock which is itself a homogeneous, 
isotropic linear elastic material. Therefore, Rigid or 
Deformable concerns only the deepest underlying 
material. 

A rigid bedrock represents an ideal medium with very 
strong mechanical characteristics compared to 
overlying multilayer soil structure. 

A deformable bedrock is modeled as a semi-infinite 
isotropic homogeneous elastic linear medium. It is 
characterized by the shear and compression body 
wave velocities and its mass density. 
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Note: when the bedrock is selected as deformable, it is 
check-marked in the menu. To disable this option, 
select this option a second time. The check-mark 
disappears to inform the user. 

 

Input Motion 
Different accelerations may be used for different Input 
Motion Components. 

For the Soil Column Frame as well as the Equivalent 
Linear Frame, the input motion is supposed to be 
defined at the outcropping bedrock at the same altitude 
as the bedrock underlying the Soil Column, as 
presented in the figure below. If the bedrock is 
considered as Deformable, then it is assumed to be an 
isotropic and homogeneous linear elastic material. 

 
 

In the Control Point Frame, the input motion is 
assumed to be given at the surface of the multilayer 
(non)linear viscoelastic rock. 
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The outcropping bedrock is the location to where the 
input motion is deconvoluated from the control point 
and where the input motion is defined for the soil 
column analysis. 

 

Menus of the various frames 

 

Main Frame 
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Main Frame Menus: 

- File, 

- Tools, 

- Window, 

- Help. 
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Soil Column Frame 
 

 

Soil Column Frame Menus: 

- File, 

- Edit, 

- Define, 

- Tools5, 

- Computing, 

- Results, 

- Window, 

- Help. 

 

 

 

 

                                                 

 
5  The same as in the Main Frame. 
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Parameter Wizard Frame 

 

 
 

Parameter Wizard Frame Menus: 

- File, 

- Edit, 

- Plastic Model, 

- Tools6, 

- Window, 

- Help. 

                                                 

 
6  The same as in the Main Frame. 
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Equivalent Linear Frame 

 

 

Equivalent-Linear Frame Menus: 

- File, 

- Edit7, 

- Define, 

- Tools8, 

- Computing, 

- Results, 

- Window, 

- Help. 

 

 

 

                                                 

 
7  The same as in the Soil Column Frame. 
8  The same as in the Main Frame. 
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Control Point Frame 
 

 
 

Control Point Frame Menus: 

- File, 

- Edit9, 

- Define, 

- Tools10, 

- Deconvolution, 

- Results, 

- Window11, 

- Help. 

                                                 

 
9  The same as in the Soil Column Frame. 
10  The same as in the Main Frame. 
11  The same as in the Equivalent Linear Frame. 
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Dockable/Floating Toolbars 
 

The following toolbars may be attached, or docked, to 
any side of the frame window, or they can be detached, 
or floated, in their own mini-frame window. Hereafter, 
they are presented as floating mini-frame windows. 
Their buttons represent shortcuts to the corresponding 
drop-down menu commands. 
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Chapter 2: Main Frame 

 

 
 

Main Frame File Menu 
In the Main Frame the following actions may be performed 
by using this menu. 

New Creates a document for a new 
multilayer soil column, for either 
a Cyber Analysis, an Equivalent 
Linear Analysis or a 
Deconvolution from a Control 
Point 

Open Opens an already existing 
multilayer soil column, for either 
a Cyber Analysis, an Equivalent 
Linear Analysis or a 
Deconvolution from a Control 
Point 
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Import Accelerogram Gets an existing accelerogram 
from a database (Cyber 
Database or Other databases) 

Export Cyber Curve Exports a Cyber curve into a 
formatted curve with Cyber 
formats (Professional versions 
Only) 

Exit Closes all windows and returns 
you to the Program Manager. 

Tools menu commands 
Following operations may be performed by using this 
menu. The same menu is also available for Soil Column, 
Parameter Wizard, Equivalent linear and Control Point 
frames. 

1. Create Analytical Function… 

2. Operations on curves… 

3. Fourier Transform 

4. Inverse Fourier Transform 

5. Response Spectrum 

6. Spectral Ratio 

7. Fourier Spectrum Smoothing 

8. Frequency Filter 

9. Base Line Correction 

10. Moduli Conversion 

11. Unit Conversion 

12. Plot 

13. Diagrams 

14. Options 
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Create Analytical Function 
Use this command to create the following analytical 
functions: 

1. Ricker wavelet 

2. Harmonic signal 

3. Tsang signal 

4. Step Function 

5. Polynomial Function 

6. Ramp Function 

7. Piecewise Linear Function 

8. Constant Function 

9. Dirac Function 

10. Decay Function 

They are useful as simplified input motions for seismic 
analysis. 

For all of these functions: 

1. Enter the Time Description. 

2. Enter specific parameters depending on the function. 

3. A plot representing the resulting curve is presented. 

4. Modify the plot features by using the toolbar buttons (to 
access the Graph utilities). 

5. Use Saving Interval to save a portion of the curve on 
an x-axis interval. The default is the whole interval. Use 
Save Curve to keep the resulting curve on disk and 
exit, or Close to quit. 

6. Use Edit Curve to edit the data values of the resulting 
curve. 

7. Use Refresh Graph to update the plot display, for 
instance after having loaded the file containing your 
Graph Templates.  
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8. If saving, choose a name for the resulting curve. 

Ricker Wavelet 
The Ricker Wavelet is very often used in seismology as the 
input motion. It is in fact very simple in time domain and in 
frequency domain. It vanishes gently with respect to the 
frequency and it does not introduce any cut-off effects. The 
form of the signal depends on two parameters; ts 
represents the time of maximum value and tp is a 
characteristic period. 

Different orders may be considered for this signal. The 
most commonly used orders are: 

0th Order 

 
1st Order 

( ) ( ) 1 2
1 02f t a f t e= −  

 

2nd Order 

( ) ( ) ( )
3 2

2
2 01 2

2
ef t a f t= −  
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3rd Order 

( ) ( ) ( )
3 2 3 2

3
3 03 2

3 2 3 2 3 2

ef t a a f t
−

= − −
− ⋅

 

Harmonic Signal 
The harmonic signal is of certain interest in seismic 
computations. The parameters used in the definition of a 
harmonic function may be understood from the figure. 

 

 
 

Tsang Signal 
The Tsang signal is of certain interest in seismic 
computations. More specifically, the decay function results 
in a more realistic signal than the harmonic one in the 
context of seismic analysis. 
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The parameters used in the definition of a tsang function 
may be understood from the figure. 
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Step Function 
The step function is defined as: 

( ) 0t tf t Thresh Amplit E
Dt

Dt t Step

−⎛ ⎞= × × ⎜ ⎟
⎝ ⎠

= −
 

 

 

Polynomial Function 
The polynomial function is defined as: 

10
0 1 10( )f t a a t a t= + + +K  

Ramp Function 
The ramp function is defined as: 

0 1( )f t a a t= +  
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Piecewise Linear Function 
The piecewise linear function is composed of N ramp 
functions, defined as: 

[ ] [ ]
( ) ( ) ( )

1

0 1 1

1, , , ,

and
+

−

∀ ∈ ∀ ∈

= + =
i i

i i i i i i

i N t t t

if t a a t f t f t
 

Constant Function 
The constant function is defined as: 

( ) 0,t f t f∀ =  

Dirac Function 
The dirac function is defined as: 

( ) ( )0 and , 0i if t f t t f ti= ∀ ≠ =  

Decay Function 
The decay function is defined as: 

( ) ctf t Amplit e−= ×  

Operation on curves 
The following operations may be performed by using this 
menu: 

1. Convert Format 

2. Interpolate 

3. Least Squares Fitting 

4. Operators 

5. Curve (X=f(x),Y=g(x)) 
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Convert Format 
Use this command from Operations on curves command in 
the Tools drop-down menu command to convert your files 
into Cyber Formats. 

Using this command: 

1. In the first dialog box that appears: 

 - select the format-type of the file (either Cyber 
Formats or Other), 

 - select the format-type of the input data ((x,f(x)) or 
f(∆x) given by constant step ∆x), 

 - select the separator-type of the input data and the 
decimal number format, 

 - choose the format-type of the output data data 
((x,f(x)) or f(∆x) given by constant step ∆x). 

2. If the input data is given with a constant step, enter the 
initial step and x values in the dialog box that appears. 
Then, if the output data is also required by a constant 
step, enter the interpolation step in the last dialog box 
that appears. 

3. Open the file containing the curve. 

4. Enter the number of lines to skip at the beginning of 
the original file. 

5. Choose a file name for the resulting curve in the 
proposed directory, or use the mouse to scroll through 
a different drive or directory, until you see the directory 
where you want to save the curve in. 
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Cyber Formats 
All files produced by CyberQuake are proprietary binary 
files. Use Export Cyber Curve from any File drop-down 
menu commands to convert them into Formatted files. 

The files used by CyberQuake are either formatted or 
unformatted. 

Use Convert Format command from the Tools drop-down 
menu command to convert your own data to Cyber 
Formats if necessary. 

 

Two formats are possible: 

f(∆x) type data:  
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(x,f(x)) type data: 

 

 
 

 

Note: 
1. The unformatted curves generated by CyberQuake have 
cyb as extension. The default extension for formatted 
Cyber curves is cyt. 
2. The Natural Accelerograms in the Cyber Database have 
a Cyber binary format and should not be converted to 
Cyber Format. 
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Interpolate 
Use this command in the Operations on curves menu from 
Tools drop-down menu command to perform the 
interpolation of a function f(x) (curve) to the desired 
constant step. 

Using this command: 

1. Enter the interpolation step. 

2. Open the file containing the function you want to 
operate on. 

3. A plot representing the interpolated function will be 
presented. 

4. Modify the plot features by using the toolbar buttons (to 
access the Graph utilities). 

5. Use Saving Interval to save a portion of the curve on 
an interval of x-axis. The default is the whole interval. 
Use Save Curve to keep the resulting curve on disk 
and exit, or Close to quit. 

6. Use Edit Curve to edit the data values of the resulting 
curve. 

7. Use Refresh Graph to update the plot display, for 
instance after having loaded the file containing your 
Graph Templates.  

8. If saving, choose a name for the resulting curve. 

Least Squares Fitting 
Use this command in the Operations on curves menu from 
Tools drop-down menu command to perform a least 
squares fitting of a function f(x) (curve) by a polynom of the 
desired order. 

Using this command: 

1. Open the file containing the function you want to 
operate. 

2. A plot representing the initial curve will be presented. 



 Main Frame 35 

3. Use Least Square Fitting to choose the order of the 
polynomial function. 

4. A plot representing the initial curve as well as the 
polynomial function will be presented. Operations 3 
and 4 may be repeated for other orders. 

5. Modify the plot features by using the toolbar buttons. 

6. Use Edit Curve(s) to edit the data values of the 
displayed curve(s). Use Save Curve(s) to keep the 
resulting curve(s). 

7. Use Select Curve(s) or Delete Curve(s) to select or 
delete a set of curves. 

8. Use Refresh Graph to update the plot display, for 
instance after having loaded the file containing your 
Graph Templates.  

9. Use Reset Graph to come back to the original curve(s). 

10. Use Copy to Clipboard to copy the displayed curve(s) 
to the clipboard for further use in Windows 
environment. 

11. Use Toggle Legends to enable/disable the legends for 
presented curves. 

12. If saving, choose a name for the resulting curve. 
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Operators 

 
 

Several operations may be used on curves by using the 
following basic operators: 

1. Operations concerning a single curve. 

|f(x)| Absolute value of f(x) 

|f(1/x)| Expressing f(x) as a function of 1/x 

cos(f(x)) Cosines of f(x) 

sin(f(x)) Sinus of f(x) 

10f(x) Ten to power of f(x) 

Ln|f(x)| Natural (or Napierian) Logarithm of |f(x)| 

log|f(x)| Logarithm of |f(x)| 

ef(x) Exponential (or antilogarithm) of f(x) 

f'(x) Numerical derivation of f(x) with respect 
to x. An implicit one-step Theta method 
is used to perform the numerical 
derivation 
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∫f(x) Numerical integration of f(x) with 
respect to x. An implicit one-step Theta 
method is used to perform the 
numerical integration. 

∫∫f(x) Numerical integration of f(x) with 
respect to x by using Newmark 
Integration Method.  

Using either of these commands: 

1. Open the file containing the curve f(x). 

2. A plot representing the modified curve 
appears. 

3. Modify the plot features by using the 
toolbar buttons (to access the Graph 
utilities). 

4. Use Edit Curve to edit the data values 
of the displayed curve. 

5. Use Saving Interval to save a portion of 
the curve on an interval of x-axis. The 
default is the whole interval. Use Save 
Curve to keep the resulting curve on 
disk and exit, or Close to quit. 

6. If saving, choose a name for the 
resulting curve. 

7. Use Refresh Graph to update the plot 
display, for instance after having loaded 
the file containing your Graph 
Templates. 

8. For double-integration of a curve, 
operations 3 to 7 are repeated for the 
second integration of f(x) with respect to 
x. 

 

 Newmark 

 The Newmark integration scheme is given as: 
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 With a suitable choice of integration parameters ( γ  > 
0.5, β  >0.25) it is possible to introduce frequency-
dependent numerical damping into computation. 

 This scheme is used in this software for integrating 
dynamic equations in transient domain. The default 
values are γ = 0.5, β =0.25. To select other values in 
the Time Description dialog box that appears when 
using Time History,  press Coefficients button. 

2. Operations involving a single curve and a scalar. 
 (c+x,f(x)) Translate the curve by adding a scalar 

following x-axis 
 (x,c+f(x)) Translate the curve by adding a scalar 

following y-axis 
 (x,f(c×x)) Multiply the curve by a scalar following 

x-axis 
 (x,c×f(x)) Multiply the curve by a scalar following 

y-axis 
 f(x)c Modify the curve by bringing the y-axis 

values to a power (c) 
 f(x)/c Divide the curve by a scalar following y-

axis 

Using either of these commands: 

1. Enter the scalar quantity. 

2. Open the file containing the curve f(x). 

3. A plot representing the modified curve 
appears. 
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4. Modify the plot features by using the 
toolbar buttons (to access the Graph 
utilities). 

5. Use Saving Interval to save a portion of 
the curve on an interval of x-axis. The 
default is the whole interval. Use Save 
Curve to keep keep the resulting curve 
on disk and exit, or Close to quit. 

6. Use Edit Curve to edit the data values 
of the displayed curve. 

7. Use Refresh Graph to update the plot 
display, for instance after having loaded 
the file containing your Graph 
Templates. 

8. If saving, choose a name for the 
resulting curve 

 

3. Operations involving two curves. 

 Union: 

 f(x)+g(x) Add two curves f(x) and g(x) 

 f(x)-g(x) Subtract g(x) from f(x) 

 Intersection: 

 f(x)+g(x) Add two curves f(x) and g(x) on the 
common interval on x-axis 

 f(x)-g(x) Subtract g(x) from f(x) on the common 
interval on x-axis 

 f(x)×g(x) Multiply two curves f(x) and g(x) on the 
common interval on x-axis 

 f(x)/g(x) Divide f(x) by g(x) on the common 
interval on x-axis 

 In Union, the operation is made over the interval of x-
axis representing the union of intervals of both curves. 
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 In Intersection, the operation is made over the interval 
of x-axis representing the intersection of intervals of 
both curves. 

 For any operation, the curves are not supposed to 
have the same number of points and may have been 
defined on different abscissa (x-coordinate) intervals. 

 

 Selecting either of these commands: 

 1. Open the file containing the first curve. 

 2. Restart the operation for the second curve. 

 3. A plot representing the resulted curve appears. 

 4. Modify the plot features by using the toolbar buttons 
(to access the Graph utilities). 

 5. Use Saving Interval to save a portion of the curve 
on an interval of x-axis. The default is the whole 
interval. Use Save Curve to keep the resulting curve 
on disk and exit or Close to quit. 

 6. Use Edit Curve to edit the data values of the 
displayed curve. 

 7. Use Refresh Graph to update the plot display, for 
instance after having loaded the file containing your 
Graph Templates. 

 8. If saving, choose a name for the resulting curve. 
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Curve (X=f(x),Y=g(x)) 
Use this command menu to either: 

• Display or Rotate two real functions f(x) and g(x), as a 
parametric real curve {C=Y(X), with X= f(x) and 
Y=g(x)}, 

• or Display one complex function Z(x), as a parametric 
real curve {C=Y(X), with X= Re[Z(x)] and Y=Im[Z(x)]}, 

• or create a Complex curve {C=Z(x), with Z(x) = f(x) + i 
g(x)} with f(x) and g(x), two real functions and i2 = -1. 

 

Display 
Displays the parametric curve {C=Y(X), with X= f(x) and 
Y=g(x)} or {C=Y(X), with X= Re[Z(x)] and Y=Im[Z(x)]}. 

To use this command: 

1. Open the first file containing the real function X=f(x) or 
the file containing the complex curve. 

2. Open the second file containing the real function 
Y=g(x), when dealing with two real functions. 

3. A plot of the resulted curve (C) is shown. 

4. Use Saving Interval to save a portion of the curve on 
an x-axis interval. The default is the whole interval. 

5. Use Edit Curve to edit the data values of the displayed 
curve. 

6. Click on Save Curve to save the curve on disk and exit, 
or on Close to quit the plot. 

7. Use Refresh Graph to update the plot display, for 
instance after having loaded the file containing your 
Graph Templates. 

8. If saving, choose a name for the resulting curve. 
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Rotate 
Projects one parametric curve {C=Y(X), with X= f(x) and 
Y=g(x)} on a new basis obtained after rotation. 

Using this command: 

1. Open the first file containing the real function X=f(x). 

2. Open the second file containing the real function 
Y=g(x). 

3. Enter the scalar quantity representing the rotation 
angle (in degrees). 

4. A plot representing the new curves appears. 

5. Modify the plot features by using the toolbar. 

6. Use Saving Interval to save a portion of the curve on an 
x-axis interval. The default is the whole interval. Use 
Save Curve to keep the resulting curve on disk and 
exit, or Close to quit. 

7. Use Edit Curve to edit the data values of the displayed 
curve. 

8. Use Refresh Graph to update the plot display, for 
instance after having loaded the file containing your 
Graph Templates. 

9. If saving, choose a name for the resulting curve. 

 

Complex 
Creates one complex curve {C=Z(x), with Z(x) = f(x) + i 
g(x)}, with f(x) and g(x), two real functions and i2 = -1. 

Using this command: 

1. Open the first file containing the real function X=f(x). 

2. Open the second file containing the real function 
Y=g(x). 

3. A plot representing the imaginary part versus the real 
one of the complex curve appears. 
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4. Modify the plot features by using the toolbar. 

5. Use Saving Interval to save a portion of the curve on an 
x-axis interval. The default is the whole interval. Use 
Save Curve to keep the resulting curve on disk and 
exit, or Close to quit. 

6. Use Edit Curve to edit the data values of the displayed 
curve. 

7. Use Refresh Graph to update the plot display, for 
instance after having loaded the file containing your 
Graph Templates. 

8. If saving, choose a name for the resulting complex 
curve. 

Fourier Transform 
Use this command to compute the Fourier Transform of a 
curve. 

The Fourier Transform used in CyberQuake is defined as: 

dte)t(f)(F ti∫
+∞

∞−
−= ωω  

Note: A Fast Fourier Transform is used to perform this 
operation. The minimum number of discrete values 
considered in FFT is 8192. If the curve results in less 
number of values, it will be completed by zeros. If it results 
in more values, the number of points to be considered will 
be the first power of two immediately over the number of 
points provided completed by zeros. 

Using this command: 

1. Select a Frequency Filter and define the type of output 
(Amplitude, Phase and/or Complex). 

2. Open the file containing the curve. 

3. One, two or four curves will be displayed sequentially 
depending on the type of output requested. 

4. Modify the plot features by using the toolbar. 
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5. Use Saving Interval to save a portion of the curve on 
an interval of x-axis. The default is the whole interval. 
Use Save Curve to keep the resulting curve on disk 
and exit, or Close to quit. 

6. Use Edit Curve to edit the data values of the displayed 
curve(s). 

7. Use Refresh Graph to update the plot display, for 
instance after having loaded the file containing your 
Graph Templates. 

8. If saving, choose a name for the resulting curve. 

 

Inverse Fourier Transform 
Use this command to compute the Inverse Fourier 
Transform of a curve. 

The Inverse Fourier Transform used in CyberQuake is 
defined as: 

ωω
π

ω de)(F
2
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+∞

∞−
−=  

 

Note: A Fast Fourier Transform is used to perform this 
operation. The function F(ω) is furnished either as 
Amplitude and Phase (in degrees) or as Complex. 
Therefore two curves should be provided. The minimum 
number of discrete values considered is 8192. If curves 
contain less number of values, they will be completed by 
zeros. If they contain more values the number of points to 
be considered will be the first power of two immediately 
over the number of points provided completed by zeros. 

Using this command: 

1. Define the nature of the curves containing data to be 
processed. 

2. Open the file(s) containing the curves. 
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3. Click on the name of the first file containing the 
Amplitude values, then click on the Open button; or 
just double-click on the name of the file. 

4. Click on the name of the second file containing the 
Phase values, then click on the Open button; or just 
double-click on the name of the file. 

5. Click on the name of the file containing the Complex 
values (Real and Imaginary parts), then click on the 
Open button; or just double-click on the name of the 
file. 

5. A plot representing the Inverse Fourier Transform 
appears. 

6. Modify the plot features by using the toolbar. 

7. Use Saving Interval to save a portion of the curve on 
an interval of x-axis. The default is the whole interval. 
Use Save Curve to keep the resulting curve on disk 
and exit, or Close to quit. 

8. Use Edit Curve to edit the data values of the displayed 
curve(s). 

9. Use Refresh Graph to update the plot display, for 
instance after having loaded the file containing your 
Graph Templates. 

10. If saving, choose a name for the resulting curve. 

Response Spectrum 
Use this command from the Tools menu command in any 
frame to compute the response spectra. It corresponds to 
the response of a damped oscillator subjected to an 
acceleration. The maximum motion (Displacement, 
Velocity, Acceleration, Pseudo-velocity or Pseudo-
acceleration) obtained for each value for the eigen 
frequency of the oscillator is displayed with respect to the 
eigen period, eigen frequency or eigen angular frequency. 
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The Pseudo-velocity response spectrum is the product of 
displacement with the eigen frequency of the oscillator. It is 
the most commonly used spectrum in engineering. 

The Pseudo-acceleration response spectrum is the product 
of displacement with the square of the eigen frequency of 
the oscillator. 

Several methods may be used to calculate the solution. In 
CyberQuake, a transient approach is used and the 
equation is resolved numerically. 

Using this command: 

1. Enter the damping ratio in percent (default is 5%), the 
number of discretization steps (default is 500), the 
interval for the frequency of the oscillator (default is 
0.25 to 50 Hz) and select the output characteristics. 
Type Default to display default values. Type Cancel to 
quit. 

2. Open the file containing the input acceleration. 

3. The resulting curve will be displayed. 

4. Modify the plot features by using the toolbar. In general 
the response spectra are presented in indifferently lin-
lin, lin-log or log-log space. Here, the lin-lin 
presentation space is adopted. Use the Graph Icons to 
change the presentation. 

5. Use Saving Interval to save the curve on a given 
interval of x-axis. Use Save Curve to keep the resulting 
curve on disk and exit, or Close to quit. 

6. Use Edit Curve to edit the data values of the displayed 
curve(s). 

7. Use Refresh Graph to update the plot display, for 
instance after having loaded the file containing your 
Graph Templates. 

8. If saving, then choose the names for the curves. 
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Note: in general the response spectra are computed with a 
5% damping ratio. 
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Spectral Ratio 
Use this command from the Tools menu command in all 
frames to compute the spectral ratio. The term Spectral 
Ratio is in general attributed to the ratio between the output 
results (e.g. acceleration) and input motion (e.g. input 
acceleration) presented in Fourier domain. Here, the ratios 
between the Fourier Amplitudes of two transient quantities 
with respect to frequency are presented. 

Using this command: 

1. Open the file containing the first transient curve. 

2. Open the file containing the second transient curve. 

3. Then, a dialog box appears asking whether the Fourier 
Amplitude of curves should be smoothed before the 
ratio is computed or not (see Fourier Spectrum 
Smoothing). 

4.  If Yes, enter the bandwidth of the running mean-square 
smoothing window 

5. The resulting Spectral Ratio appears. 

6. Modify the plot features by using the toolbar. 

7. Use Saving Interval to save the curve on a given 
interval of x-axis. Use Save Curve to keep the resulting 
curve on disk and exit, or Close to quit. 

8. Use Edit Curve to edit the data values of the displayed 
curve. 

9. Use Refresh Graph to update the plot display, for 
instance after having loaded the file containing your 
Graph Templates. 
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10. If saving, then choose the name for the resulting curve. 

 

Note: f(x)/g(x) from Operators in the Operation on curves 
from the Tools drop-down menu command may be also 
used for this operation, by entering the files containing both 
Fourier Amplitudes. 
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Fourier Spectrum Smoothing 
Use this command from the Tools menu command in all 
frames to smooth the Fourier Transform of a curve 
represented with respect to the frequency. 

Note: The smoothing process is based on a sliding window 
technique. The size of the window (bandwidth) is selected 
by the user. The average of values is attributed to the 
middle point in the window. The window slides on the 
following point next to the point from which the previous 
window started and the average of points in the new 
interval defined by the bandwidth is attributed to the next 
middle point. The procedure continues until the last point 
on the x-axis. To strongly smooth a curve, various 
strategies may be adopted. It is possible to use a large 
bandwidth or perform several smoothing operations with a 
smaller bandwidth. We recommend the second technique. 

Using this command: 

1. Select the size of the sliding window (bandwidth) in Hz. 

2. Open the file containing the curve. 

3. The smoothed curve is displayed. 

4. Modify the plot features by using the toolbar. 

5. Use Saving Interval to save the curve on a given 
interval of x-axis. Use Save Curve to keep the resulting 
curve on disk and exit, or Close to quit. 

6. Use Edit Curve to edit the data values of the displayed 
curve. 

7. Use Refresh Graph to update the plot display, for 
instance after having loaded the file containing your 
Graph Templates. 

8. If saving, then choose the name for the resulting curve. 
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9. Repeat the operations from 1 to 8 with the last curve 
saved on 8, until obtaining the requested degree of 
smoothing. 

 

Frequency Filter 
Use this command: 

1. Either from the Tools menu command in any frame to 
filter the frequency content of a transient curve. 

2 Or in the list boxes proposed when using the Fourier 
Transform. 

Using this command in the first case: 

1. Select the minimum and maximum frequencies 
representing the interval in which the frequency 
content will not be affected. Enter also a range for 
each limit. Each range gives the frequency interval on 
which a decay function is applied to the curve. 

2. Open the file containing the curve. 

3. The transient filtered curve is plotted. 

4. Modify the plot features by using the toolbar. 

5. Use Saving Interval to save the curve on a given 
interval of x-axis. Use Save Curve to keep the resulting 
curve on disk and exit, or Close to quit. 

6. Use Edit Curve to edit the data values of the displayed 
curve. 

7. Use Refresh Graph to update the plot display, for 
instance after having loaded the file containing your 
Graph Templates. 

8. If saving, then choose the name for the resulting curve. 
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Using this command in the second case: 

1. Select the minimum and maximum frequencies 
representing the interval in which the frequency 
content will not be affected. Enter also a range for 
each limit. Each range gives the frequency interval on 
which a decay function is applied to the curve. 

2. Click on the OK button. 

Note: a second order decay function is applied to the curve 
before the minimum and after the maximum frequency. 
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Base Line Correction 
Use this command from the Tools drop-down menu 
command to correct the base line of a natural 
accelerogram. 

In fact, unrealistic displacements or velocities may occur 
when integrating accelerations due to errors in the 
acceleration data introduced either when it is recorded or in 
subsequent manipulations. 

Three methods are available in CyberQuake: 
1. Least-Mean-Square-Velocity dv0 proposed by G.V. 

Berg and G.W. Housner (1961) in which initial velocity 
and displacement are assumed to be zero. 

2. Least-Mean-Square-Velocity d0 proposed by W.H. 
Boyce (1970) in which initial displacement is only 
assumed to be zero. 

3. End-Time-Zero proposed by J.V. Poppitz (1968) in 
which the initial acceleration and the final acceleration, 
velocity and displacement are assumed to be zero. 

The two first techniques, not sensitive to end conditions, 
are used  in general with seismic data while the last one is 
recommended for use with (nuclear-) explosion-induced 
data. 

Caution: this operation is performed on natural 
accelerograms (if necessary) before dynamic computation 
of the soil column and neither on computed results nor on 
analytical input motions. 

Using this command: 

1. Select the method you want to use in the dialog box. 

2. Open the file containing the curve you want to operate. 

3. A plot representing the corrected displacement 
appears. 

4. If the resulted displacement is satisfactory, use Save 
Curve to record the corresponding acceleration to disk 
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and exit, or type Close to quit. Use Saving Interval to 
save the acceleration on a given interval of x-axis. 

5. Use Edit Curve to edit the data values of the displayed 
curve(s). 

6. Use Refresh Graph to update the plot display, for 
instance after having loaded the file containing your 
Graph Templates. 

7. If saving then you may choose a name for each 
corrected curve. 
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Moduli Conversion 
 

 
 

Use this command to convert different moduli. 

 

Selecting this command, you can convert following triples 
very often used indifferently in practice: 

(ρ, Vp, Vs)<-->(ρ, E, ν)<-->(ρ, λ, µ)<-->(ρ, K, G) 

with: 

ρ The mass density 

Vp The compression (dilatational or first kind) body 
wave velocity 

Vs The shear (transverse or second kind) body wave 
velocity 

E The Elastic modulus 

ν The Poisson's ratio 

λ, µ The Lamé elastic coefficients 
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K The bulk (volumetric or isotropic) elastic modulus 

G The shear elastic modulus (G = µ) 

 

Unit Conversion 
 

 
 

Use this command to convert Metric to U.S. Units and vice 
versa. 

Selecting this command, you can convert Length, Area, 
Volume, Mass, Mass Density, Pressure and Force units 
used in the software. 
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Plot  
Use this command to plot one or several superimposed 
curves. 
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Diagrams 
Use this command to plot one or several curves. The origin 
of each new curve is moved vertically in order to display a 
diagram containing curves at different depths on the soil 
column profile. 

 

 
 

The maximum number of curves to be plotted 
simultaneously is 15. 

To use either of these commands: 

1. Select the command. 

2. In the list box that appears, look for the file you want to 
plot. 
Use the mouse to scroll through the list of files, or to 
open directories (by double-clicking on them), or to 
select a different drive, until you see the file you want. 

3. Select the filename(s), then click on the Open button; 
or just double-click on a filename. 
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4. Modify the plot features by using the toolbar. 

Note: Refer to Graph Help (after pressing the toolbar 
button) for further information. 

The following actions may be done when using the above 
commands: 

Clear Graph Clear all plotted graphs 

Get Curve Load curve(s) to be displayed 

Edit Curve(s) Edit the data values of the 
displayed curve(s) 

Refresh Graph Plot again all loaded curves (not 
hidden ones), to update any 
change in the settings 

Reset Graph Plot again all loaded curves (even 
hidden ones), except the deleted 
ones 

Select... Select (show or hide) curves to be 
displayed 

Delete... Delete selected curves 

Toggle Legends Enable/disable the presented 
legends 

Copy to Clipboard Copy a plot to the Clipboard for 
further use in the Windows 
environment. Once the object 
copied, you can open a Windows 
application and copy it from the 
Clipboard to a new or existing 
document 

Saving Interval Select an interval on the x-axis for 
which the displayed graph may be 
saved. Then to save the graph, use 
the Save Curve command of the 
Quick Plot 
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Save Curve Save the curve(s) displayed with 
Quick Plot and exit 

Close Quit a Quick Plot 

 

Main Frame Window menu 
In the Main Frame, the following operations may be 
performed by using this menu: 

Toolbar Enables (disables) the Toolbars in 
any Frame 

Status Bar Enables (disables) the Status Bar in 
which a brief explanation of the 
command key is given 

 

Main Frame Help menu 
In the Main Frame, the following information may be 
obtained by using this menu: 
Getting Started Explains how to get started with 

CyberQuake 

Contents Gives the contents of the 
CyberQuake Help 

Using Help Starts the Windows help engine to 
give you help on how the help 
system works. There is no default 
command key 

About CyberQuake Shows the release version and the 
names of CyberQuake authors 

Disclaimer CyberQuake and the accompanying 
files are supplied on an "as-is" 
basis. It is continually being 
developed and improved. The 
authors are interested to hear about 
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any deficiencies in order to improve 
next versions 

 As with most software, the authors 
offer no warranty of its fitness for 
any purpose whatsoever, and 
accept no liability whatsoever for 
any loss or damage incurred by its 
use 

 

Screen/Menu Help 
Enters the interactive help system that lets you point the 
mouse cursor at the menu item or screen area you want 
help on. 

Default command key: Shift+F1. 

When you use this command, the mouse cursor will 
change to become an arrow-and-question mark, to show 
that interactive help is active. 

For help on an area of the status bar or on a tool bar 
button, point the mouse cursor at the appropriate part of 
the screen and click on the left button once. For help on a 
menu item, select the item as you would do actually to use 
the command, and click on the left button. 

The software will start the Windows help engine, and will 
show the topic appropriate to where you clicked on the 
mouse button. 

If you decide you don't want interactive help after using the 
command, you can return the mouse cursor to normal by 
pressing the Escape key. 

When interactive help is operating, any keys you press will 
be ignored, and the toolbar, status bar and menu items will 
not have their normal effect. 
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Chapter 3: Soil Column Frame 

 
 

Soil Column Frame Menu: 

- File, 

- Edit, 

- Define, 

- Tools, 

- Computing, 

- Results, 

- Window, 

- Help. 
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Soil Column File menu 
In the Soil Column Frame the following actions may be 
performed by using this menu: 

New Creates a document or sheet for a new multilayer 
soil profile for transient analysis 

Open Opens an already existing 
multilayer soil profile for 
transient analysis 

Close  Closes the currently active 
document 

Save  Saves changes to the 
current document 

Save As Saves the current 
document, prompting for a 
new name 

Save Results  Saves all results obtained 
after a computation 

Load results Loads all results obtained 
and saved after a 
computation 

Import Accelerogram Gets an existing 
accelerogram from any 
database 

Export Exports a Cyber Curve into 
a formatted curve with 
Cyber Formats, or 

 Saves the current soil profile 
with a new format for a 
different analysis, or 

 Exports the elastoplastic 
constitutive model 
parameters into either a file 
or the clipboard 
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Print  Prints the current document 

Print Plastic Model Parameters Lists and prints all 
plastic constitutive model 
parameters of the current 
document 

Page Setup  Sets up the page's 
configuration 

Exit Closes all windows and 
returns you to Program 
Manager 

 

Save Results 
Use this command to save all results obtained after a 
transient (Cyber) computation. 

This may be useful when the user does not have enough 
time to save the results for each layer individually. 

The results will be associated with the document and may 
be accessed when opening this document afterwards by 
using Load Results. 

Caution: The name of the directory associated with the 
column should not be modified. Otherwise, the results may 
not be recovered. 

 

Soil Column Edit menu 
The following operations may be performed by using this 
menu: 

Copy Layer Copies a selected layer into the 
clipboard 

Cut Layer Deletes the selected layer from the 
column and copies it to the 
clipboard 
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Paste Layer Pastes the copied or cut layer to 
the column 

Add New Layer Adds a new layer at the bottom of 
the column 

Insert New Layer Inserts and embeds a new layer in 
the column 

Delete Layer Deletes the selected layer 

Copy To Clipboard Copies the selected cells in the 
active column to the clipboard 

 

Soil Column Define menu 
In the Soil Column Frame, the following definitions may be 
introduced by using this menu: 

Column Further inputs for the Soil 
Column 

Bedrock Characteristics of the 
bedrock 

Plastic Model Access graphs and model 
parameters for the 
selected Soil Layer 

Water Table Depth Location of the water table 
in the Soil Column 

 Definition of the analysis 
type : Two-Phase or 
Undrained (Advanced 
Engineering Analysis 
version Only)  

Top Load Components Definition of mechanical 
loading at the top of the 
Soil Column or display if a 
top load is set 
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Input Motion Components Choice of the Input Motion 
and its components, or 
display if an Input Motion is 
defined 

Time History Definition of the initial time 
and duration of motion for 
the analysis 

 

Column 
(Advanced Engineering Analysis version Only) 

Use this command to introduce the Slope of the Soil 
Column. 

Through the NS/Column Plane Angle command it is 
possible to introduce the angle between the Column Plane 
( i.e. The Column Plane is the plane of maximum slope) 
and North-South direction (Geographical 'absolute' North-
South Direction). 

NS/Column Plane Angle 
(Advanced Engineering Analysis version Only) 

The angle between the Column Plane; i.e. the Column 
Plane is the plane of maximum slope and the North-South 
direction is introduced by using this command. The angle 
(in degree) is positive in trigonometric direction from the 
North as presented in the figure. 
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Slope 
The Soil Column may have a slope that can be introduced 
via the Define drop-down menu command in the Soil 
Column Frame. 

This command is only applicable in the case of Rigid 

Bedrock. 

Note that the whole configuration may have a slope (the 
bedrock is parallel to the ground surface). 

When a Water Table Depth is indicated the Water table is 
assumed to be also parallel to the ground surface. 

Plastic Model 
Use this command to access to the constitutive model 
Simulator or to compute (G/D-γ) curves. 

Simulator 
To facilitate the work with the software, some soils have 
been already defined and their model parameters are 
furnished. However, in some conditions the model's 
response may not be satisfactory. For instance, the (G/D-γ) 
curves do not match experimental results. Therefore, it will 
be necessary to calibrate the model parameters. 

This command is used either to simulate and to display the 
response of the constitutive model for soils or to modify 
model parameters. 

The (G/D-γ) curves is used to the calculate the well-known 
(G-γ) and (D-γ) curves. 

Click on Other curves to perform cyclic and monotonous 
tests on the soil. 
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The model parameters for the material may be modified by 
the user for a better calibration of model parameters. 

Note:  
1. (G/D-γ) curves as well as monotonous and cyclic tests 
are evaluated for the selected Soil Layer at the confining 
pressure corresponding to the vertical stress in the Soil 
Layer as situated in the Soil Column.  
2. You should confirm the choice of the model parameters 
by clicking on Keep Parameters. Otherwise, computations 
of the Soil Column will not be enabled. 
 
(G/D-Gamma) Curves 

Use this command to compute and display the well-known 
(G-γ) and (D-γ) curves representing the variation of the 
secant shear modulus (G) and the plastic dissipation 
energy (also called the damping) with distortion (γ). 

G is normalized with respect to Gmax representing the 
maximum elastic shear modulus. The dissipated energy is 
normalized by the elastic energy necessary for the same 
amount of deformation. 

Selecting this command CyberQuake starts the 
computation of (G/D-γ) curves while showing a dialog box 
containing the button Break for aborting the computation. If 
the computation is aborted the results obtained before 
Break are displayed. 

When results are displayed: 

1. (G-γ) and (D-γ) curves appear. 

2. Use Get (Curves menu) to plot if you wish to compare 
the computed results to other (G/D-γ) curves. 

3. Use Edit (Curves menu) to edit the data values of the 
(G/D-γ) curves. 

4. Use Save (Curves menu) to keep the resulting curves 
on disk and exit, or Quit. 
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5. If saving, choose a name for the resulting curves. 

6. Use (G/Gmax,Gamma) Only (View Graphs menu) to 
display (G-γ) curve(s) only and modify the plot features 
by using the toolbar buttons ((to access the Graph 
utilities). 

7. Use (D,Gamma) Only (View Graphs menu) to display 
(D-γ) curve(s) only and modify the plot features by 
using the toolbar buttons. 

8. Use Both (View Graphs menu) to display (G-γ) and (D-
γ) curves again. 

9. Use Refresh (View Graphs menu) to update the plot 
display, for instance after having loaded the file 
containing your Graph Templates. 

10. Use Reset (View Graphs menu) if you wish to plot the 
computed curves again, without the imported curves 
loaded in 2. 

 

Water Table Depth 
Use this command to introduce the Water Table Depth. 

Selecting this command, a dialog box is opened in which 
the depth of the Water Table may be introduced. 
Consequently, the Water Table Depth is checked in the 
drop-down menu bar to remind the presence of a Water 
Table in the Soil Column and its current value is indicated. 
Moreover, a Hydraulic Condition column appears in the 
active transient column sheet and the layers below the 
Water Table will appear as Undrained or Two-Phase, 
depending on the analysis type. 

This command can be disabled by pressing the mouse 
button when the Water Table Depth is selected again. The 
Hydraulic Condition column disappears then. 

CyberQuake automatically divides the soil column into 
Drained (blue cells in the Hydraulic Condition column) and 
Undrained (or Two-Phase) parts. If the Water Table is 
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located in a given soil layer, this layer is divided into two 
sub-layers. If the Water Table is removed these sub-layers 
are not merged into one layer automatically. However, the 
presence of two sub-layers with the same properties is 
equivalent to one layer with a thickness equal to the sum of 
sub-layers' thicknesses. 

Caution: Depending on the version of CyberQuake, the 
saturated zone is handled differently. In the Engineering 
Analysis version a totally Undrained condition is assumed. 
In the Advanced Engineering Analysis version two 
approaches are possible: 
1. either, a totally Undrained assumption as in the earlier 
case. 
2. or a Two-phase formulation for porous media. In the 
latter case, permeability coefficients are required for layers 
under the Water Table. 

 

Two-phase 
(Advanced Engineering Analysis version Only) 

A Two-phase as opposed to One-phase material 
represents here a material in which the fluid phase 
(saturating water) should be considered as an independent 
phase. 

This hypothesis is necessary in the following conditions: 

1. The permeability of the soil is high. 

2. The duration of the seismic event or the external load 
(Top load) is large. 

The mass conservation equation of both solid and fluid 
phases has to be taken into account. In the formulation 
adopted here, the pore-pressure becomes a principal 
unknown and computations become more time-consuming. 
This option may be only used if physical properties and 
loading conditions do not permit a totally undrained 
hypothesis. 
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Top Load Components 
Use this command to select a dynamic loading on the top 
of the Soil Column. 

The loading may be introduced in two or three directions 
depending on the CyberQuake version: 

1. Engineering Analysis version 
 - horizontal (Absolute Geographical Horizontal 

Direction ) (in-plane) loading component, 
 - vertical (Absolute Geographical Vertical Direction ), 

both with respect to absolute referential. 
2. Advanced Engineering Analysis version 
 - NS: (Absolute Geographical) North-South horizontal 

loading component, 
 - UP: (Absolute Geographical)Vertical loading 

component, 
 - EW: (Absolute Geographical) East-West horizontal 

loading component. 

Note: The load is considered in kPa. When a component is 
defined, it is check-marked. When a selected component is 
checked a second time it is disabled and the check-mark 
disappears. 
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Input Motion 
Different accelerations may be used for different Input 
Motion Components. 

The input motion is supposed to be defined at the 
outcropping bedrock at the same altitude as the bedrock 
underlying the Soil Column. as presented in the figure. If 
the bedrock is considered as Deformable12 then it is 
assumed to be an isotropic and homogeneous linear 
elastic material. 

The outcropping bedrock to where the
input motion is deconvoluated from the
control point and where the input motion
is defined for the soil column analysis

The bedrock common
to the soil column and
multilayer rock

The soil column used
for Cyber or Equivlent
Linear Analysis

The input motion is
defined here

The output result
will be always
available here

 

Input Motion Components 
Use this command to select the components of the Input 
Motion. 

Note: In the Engineering Analysis version, Vertical and 
Horizontal components may be introduced. In the 

                                                 

 
12 A deformable bedrock is modeled as a semi-infinite isotropic 

homogeneous elastic linear medium. It is characterized by the shear 
and compression body wave velocities and its mass density. 
When the bedrock is selected as deformable it is check-marked in 
the menu. To disable this option select this option a second time. 
The check-mark disappears to inform the user. 
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Advanced Engineering Analysis version, Vertical, North-
South and East-West components may be introduced. 

Vertical An 'Absolute' Geographical Vertical 
Direction 

Horizontal An 'Absolute' Geographical 
Horizontal Direction 

North-South An 'Absolute' Geographical North-
South Direction 

East-West An 'Absolute' Geographical East-
West Direction 

 

Time History 
Use this command in the Define drop-down menu 
command to enter the time history for the computation. 

Selecting this command, enter the starting time, ending 
time and the Saving Time Step. 

You can also choose a Step Coefficient to which the 
Computation Time Step selected by CyberQuake will be 
multiplied. This will be useful if the computation seems to 
be diverging. For this frame it is also possible to select 
bottom Coefficients to access Newmark algorithm 
coefficients. Default values for these parameters are: γ=0.5 
and β=0.25. Selecting higher values for these parameters 
introduce frequency-dependent numerical damping in 
computation.  

It may be useful for nonlinear analysis in which very high 
frequencies due to the non linearity may be undesirable. 

 

Soil Column Tools menu 
See the Tools menu in the Main Frame (Chapter 2). 

 



 Soil Column Frame 75 

Soil Column Computing menu 
Following actions may be performed by using this menu: 

- Checklist, 

- Start Cyber Analysis or Continue Cyber Analysis, 

- Break Cyber Analysis. 

Checklist 
This command lists the data required for starting the 
computation. 

 

Start Analysis 
The command is enabled only if all data13 needed for a 
computation have been furnished. 

Using this command in a dialog box appears displaying 
some information such as the proposed Time Step, the 
Time History , the Maximum Frequency of the Input Motion 
and the Saving Time Step. These data may not be 
modified at this stage. 

Type Cancel if you do not want to pursue the computation 
or if you want to modify the data. 

Type Start to perform computations. 

                                                 

 
13 The data needed for a computation are: 

1- Thickness, Vs, Vp and ρ, for each layer. In elastoplastic 
computations using Cyber Constitutive Model the selected 
parameters should be confirmed by clicking on Keep 
parameters in the Constitutive Model Dialog Box. 

2- Either an Input Motion (and/) or a Top Load 
3- The Time History 
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Moreover, for at least one layer the Output must have been 
asked for. 

Interrupt 
Use this command from the dialog box displayed during a 
Cyber Analysis to interrupt the computation. 

The results computed before interrupting are available and 
may be displayed by using Results drop-down command. 

It is possible to perform calculations in other documents 
during the interruption and the results are not lost as far as 
the session or the interrupted document are not closed. 

Use Continue Cyber Analysis to continue the interrupted 
computations. 

Note: It is not possible to modify the data relative to the 
interrupted document. 

 

Continue Cyber Analysis 
Use this command from the Computing drop-down 
command to continue an interrupted Cyber Analysis. 

It is possible to continue calculations as far as the session 
or the document containing the interrupted calculation are 
not closed. 

Note: It is not possible to modify the data concerning the 
interrupted document. 

Break Cyber Analysis 
Use this command: 

- either from the Computing drop-down command, 

- or from the dialog box displayed during a Cyber 
Analysis, 

to break down a Cyber Analysis. 
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The results computed before this command are available 
and may be displayed by using Results drop-down 
command. 

Note: It is not possible to continue the computation after 
this command. 
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Soil Column Results menu 
The following actions may be performed by using this 
menu: 

- Current Layer, 

- All Layers, 

- Permanent Settlement At Ground Surface. 

Current Layer 
The following information may be obtained for each soil 
layer, by using this menu: 

- Displacement, 

- Velocity, 

- Acceleration, 

- Pore-Pressure, 

- Total Stress, 

- Effective Stress, 

- Total Strain, 

- Plastic Strain, 

Note: this menu may be accessed by clicking on the right 
button of the mouse. 

All Layers 
The previous information may be also obtained for all the 
soil layers at once (see Current Layer drop-down menu). 

Displacement 
Use this command to plot the displacement time history 
computed at the top of the selected soil layer or for all the 
soil layers. 
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Velocity 
Use this command to plot the velocity time history 
computed at the top of the selected soil layer or for all the 
soil layers. 

Acceleration 
Use this command to plot the acceleration time history 
computed at the top of the selected soil layer or for all the 
soil layers. 

Pore-Pressure 
Use this command to plot the pore-pressure time history 
computed at the middle of the selected soil layer or for all 
the soil layers. 

Effective Stress 
Use this command to plot the effective stress time history 
(volumetric and shear) computed at the middle of the 
selected soil layer or for all the soil layers. 

The effective stress is expressed as: 

' p Iσ σ= −  

where the first term in the right hand side is the total stress 
and the second is the pore pressure multiplied by the unit 
tensor. 

Total Strain 
Use this command to plot the total strain time history 
(volumetric and shear) computed at the middle of the 
selected soil layer or for all the soil layers. 
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Plastic Strain 
Use this command to plot the time history of the plastic 
strain components (volumetric and shear) computed at the 
middle of the selected soil layer or for all the soil layers. 

Note: These commands may be accessed by clicking on 
the right button of the mouse when a soil layer is selected. 

Once the curve is displayed: 

1. Modify the plot features by using the toolbar. 

2. Use Saving Interval to save a portion of the curve on 
an interval of x-axis. The default is the whole interval. 
Use Save Curve to keep the curve on disk and exit, or 
Close to quit. 

3. Use Edit Curve to edit the data values of the displayed 
curve(s). 

4. If saving, choose a name for the resulting curve(s). 

5. The data will be saved in Cyber Format and may be 
processed later. 

Note: If the data is not saved before quitting the session it 
will be lost. 

Permanent Settlement At Ground Surface 
The permanent settlement is the irreversible vertical 
displacement at the end of the computation. 

If the Water Table is defined in the Soil Column, the 
permanent settlement represents the irreversible vertical 
settlement after dissipation of the pore-pressure generated 
in the saturated elastoplastic material subjected to dynamic 
loading and under undrained condition. 
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Soil Column Window Menu 
New Window Use this command from the 

Window drop-down menu 
command to make an exact copy of 
the current window. The duplicate 
window created by this command 
shows the same file, with the caret 
in exactly the same place. All 
aspects of the new window are 
identical to the original. 

You can produce as many 
duplicates of a window as you wish, 
and edit the same file in each of 
them. There is no default command 
key. 

Toolbar Enable (disable) the Toolbars in all 
Frames 

Status Bar Enable (disable) the Status Bar in 
which a brief explanation of the 
command key is given 

Run-Time Plot Use this command from Window 
drop-down menu command to 
display an interactive plot of a 
selected component of the 
computed Acceleration at the 
ground surface during calculation 
when performing a Cyber Analysis. 
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Soil Column Help Menu 
Contents Gives the contents of the 

CyberQuake Help 

How to... Explains how to reduce the 
computation time when performing 
transient calculations by 
CyberQuake. 

Trouble Shootings Explains the origin of some 
difficulties when using CyberQuake 
and proposes some solutions. 

Using Help Starts the Windows help engine to 
give you help on how the help 
system works. There is no default 
command key 

About CyberQuake Shows the release version and the 
names of CyberQuake authors 

Disclaimer CyberQuake and the accompanying 
files are supplied on an as-is basis. 
It is continually being developed 
and improved. The authors are 
interested to hear about any 
deficiencies in order to improve 
next versions 

 As with most software, the authors 
offer no warranty of its fitness for 
any purpose whatsoever, and 
accept no liability whatsoever for 
any loss or damage incurred by its 
use 
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Chapter 4: Parameter Wizard Frame 

 
 

Parameter Wizard Frame Menu: 

- File, 

- Edit, 

- Plastic Model, 

- Tools, 

- Window, 

- Help. 
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Parameter Wizard File menu 
In the Parameter Wizard Frame, the following actions may 
be performed by using this menu: 

Close Closes the currently active 
document or sheet (without 
saving). 

Save Wizard Parameters Saves the elastoplastic 
Constitutive Model Parameters 
to a text file. 

Export Wizard Parameters Exports the parameters 
computed by the Parameter 
Wizard, into the original soil 
profile. 

Print Prints the Parameter Wizard 
sheet. 

Parameter Wizard Edit menu 
In the Parameter Wizard Frame, the following action may 
be performed by using this menu: 

Copy To Clipboard  Copies the document (sheet 
cells) to the Clipboard. 

Parameter Wizard Plastic Model menu 
In the Parameter Wizard Frame, the following actions may 
be performed by using this menu: 

Simulator  Launches the Cyber Constitutive 
Model simulator. 

(G/D-Gamma) Curves. Computes the well-known (G-γ) 
and (D-γ) curves. 
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Simulator 
See the Define Menu / Plastic Model / Simulator command 
in the Soil Column Frame (Chapter 3) for explanations on 
this command. 

(G/D-Gamma) Curves 
See the Define Menu / Plastic Model / (G-D-Gamma) 
Curves command in the Soil Column Frame (Chapter 3) for 
explanations on this command. 

Parameter Wizard Tools menu 
See the Tools menu in the Main Frame (Chapter 2). 

Parameter Wizard Window menu 
Toolbar Enable (disable) the Toolbars in all 

Frames 

Status Bar Enable (disable) the Status Bar in 
which a brief explanation of the 
command key is given 

 

Parameter Wizard Help menu 
Contents Gives the contents of the 

CyberQuake Help 

Using Help Starts the Windows help engine to 
give you help on how the help 
system works. There is no default 
command key 

About CyberQuake Shows the release version and the 
names of CyberQuake authors 

Disclaimer CyberQuake and the accompanying 
files are supplied on an "as-is" 
basis. It is continually being 
developed and improved. The 
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authors are interested to hear about 
any deficiencies in order to improve 
next versions 

 As with most software, the authors 
offer no warranty of its fitness for 
any purpose whatsoever, and 
accept no liability whatsoever for 
any loss or damage incurred by its 
use 
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Chapter 5: Equivalent-Linear Frame 

 
 

Equivalent-Linear Frame Menu: 

- File, 

- Edit, 

- Define, 

- Tools, 

- Computing, 

- Results, 

- Window, 

- Help. 
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Equivalent Linear File menu 
In the following actions may be performed by using this 
menu: 

New Creates a document or sheet for a 
new multilayer soil profile for an 
Equivalent Linear Analysis 

Open Opens an already existing 
multilayer soil profile for an 
Equivalent Linear Analysis 

Close Closes the currently active 
document 

Save Saves changes to the current 
document 

Save As Saves the current document, 
prompting for a new name 

Import Accelerogram Gets an existing accelerogram from 
any database 

Export Exports a Cyber Curve into a 
formatted curve with Cyber 
Formats, or 

 Saves the current soil profile with a 
new format for a different analysis 

Print Prints the current document 

Page Setup Sets up the page's configuration 

Exit Closes all windows and returns you 
to Program Manager 

 

Equivalent Linear Edit menu 
See the Edit menu in the Soil Column Frame (Chapter 3). 
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Equivalent Linear Define menu 
The following definitions may be introduced by using this 
menu: 

NS-axis/Column Plane Angle Angle between the Column 
Plane14 and the North-South15 
direction 

Bedrock Characteristics of the bedrock 

(G/D-Gamma) Curves Access (G/D-γ) curves for the 
selected layer 

Input Motion Components Choice of the Input Motion 
(only Horizontal Component 
in Engineering Analysis 
version), or display if an Input 
Motion is defined 

Time History Definition of the initial time 
and duration of motion for the 
analysis 

(G/D-Gamma) Curves: use this command to either import, 
modify, create or only display a (G-γ) curve, a (D-γ) curve 
or Both (G-γ) and (D-γ) curves. 

G is normalized with respect to Gmax representing the 
maximum elastic shear modulus. The dissipated energy is 
normalized by the elastic energy necessary for the same 
amount of deformation. 

When results are displayed: 

1. (G-γ) and (D-γ) curves appear. 

2. Use Get (Curves menu) if you wish to compare your 
curves to other (G/D-γ) curves. 

                                                 

 
14 The Column Plane is the plane of maximum slope. 
15 Geographical (absolute) North-South Direction. 
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3. Use Edit (Curves menu) to edit the data values of the 
displayed curves. 

4. Use Save (Curves menu) to keep the curves on disk 
and exit, or Quit. 

5. If saving, choose a name for the curves. 

6. Use (G/Gmax,Gamma) Only (View Graphs menu) to 
display (G-γ) curve(s) only and modify the plot features 
by using the toolbar buttons ((to access the Graph 
utilities). 

7. Use (D,Gamma) Only (View Graphs menu) to display 
(D-γ) curve(s) only and modify the plot features by 
using the toolbar buttons. 

8. Use Both (View Graphs menu) to display (G-γ) and (D-
γ) curves again. 

9. Use Refresh (View Graphs menu) to update the plot 
display, for instance after having loaded the file 
containing your Graph Templates. 

10. Use Reset (View Graphs menu) if you wish to plot your 
curves again, without the imported curves loaded in 2. 

 

Equivalent Linear Tools menu 
See the Tools menu in the Main Frame (Chapter 2). 

 

Equivalent Linear Computing menu 
The following action may be performed by using this menu. 

Checklist 
This command lists the data required for starting the 
computation. 
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Start Equivalent Linear Approximation 
The command is enabled only if all data16 needed for a 
computation have been furnished. 

 

Equivalent Linear Results menu 
The following actions may be performed by using this 
menu: 

- Current Layer, 

- All Layers. 

Current Layer 
The following information may be obtained for each soil 
layer, by using this menu: 

- Displacement. 

- Velocity. 

- Acceleration. 

- Total Stress. 

- Total Strain. 

                                                 

 
16 The data needed for a computation are: 

1- Thickness, Vs, Vp and ρ, for all layers 
2- (G-γ), (D-γ) Curves for all layers, except the Bedrock or 

Outcropping Bedrock 
3- An Input Motion 
4- The Time History 
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Note: This menu may be accessed by clicking on the right 
button of the mouse. 

All Layers 
The previous information may be also obtained for all the 
soil layers at once (see Current Layer drop-down menu). 

Equivalent Linear Window menu 
New Window Use this command from the 

Window drop-down menu 
command to make an exact copy of 
the current window. The duplicate 
window created by this command 
shows the same file, with the caret 
in exactly the same place. All 
aspects of the new window are 
identical to the original. 

You can produce as many 
duplicates of a window as you wish, 
and edit the same file in each of 
them. There is no default command 
key. 

Toolbar Enable (disable) the Toolbars in all 
Frames 

Status Bar Enable (disable) the Status Bar in 
which a brief explanation of the 
command key is given 

 

Equivalent Linear Help menu 
Contents Gives the contents of the 

CyberQuake Help 

Using Help Starts the Windows help engine to 
give you help on how the help 
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system works. There is no default 
command key 

About CyberQuake Shows the release version and the 
names of CyberQuake authors 

Disclaimer CyberQuake and the accompanying 
files are supplied on an "as-is" 
basis. It is continually being 
developed and improved. The 
authors are interested to hear about 
any deficiencies in order to improve 
next versions 

 As with most software, the authors 
offer no warranty of its fitness for 
any purpose whatsoever, and 
accept no liability whatsoever for 
any loss or damage incurred by its 
use 

 

 





 Control Point Frame 95 

Chapter 6: Control Point Frame 

 
 

Control Point Frame Menu: 

- File, 

- Edit, 

- Define, 

- Tools, 

- Deconvolution, 

- Results, 

- Window, 

- Help. 
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Control Point File menu 
In the Control Point Frame the following actions may be 
performed by using this menu: 

New Creates a document or sheet for 
a new multilayer soil profile for a 
Deconvolution from a Control 
Point 

Open Opens an already existing 
multilayer soil profile for a 
Deconvolution from a Control 
Point 

Close Closes the currently active 
document 

Save Saves changes to the current 
document 

Save As Saves the current document, 
prompting for a new name 

Import Accelerogram Gets an existing accelerogram 
from any database 

Export Exports a Cyber Curve into a 
formatted curve with Cyber 
Formats, or 

 Saves the current soil profile 
with a new format for a different 
analysis 

Print Prints the current document 

Page Setup Sets up the page's configuration 

Exit Closes all windows and returns 
you to Program Manager 

 

Control Point Edit menu 
See the Edit menu in the Soil Column Frame (Chapter 3). 
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Control Point Define menu 
In the Control Point Frame, the following definitions may be 
introduced by using this menu: 

NS-axis/Column Plane Angle Angle between the Column 
Plane17 and the North-
South18 direction 

Bedrock Characteristics of the 
bedrock 

G/D-Gamma Curves Access G/D-γ curves for 
the selected layer 

Input Motion Components Choice of the input motion 
(only Horizontal 
Component in Engineering 
Analysis version), or 
display if an Input Motion is 
defined 

Time History Definition of the initial time 
and duration of motion for 
the analysis 

 

Input Motion 
Different accelerations may be used for different Input 
Motion Components. 

The input motion is supposed to be defined at the 
outcropping bedrock at the same altitude as the bedrock 
underlying the Soil Column. as presented in the figure. If 

                                                 

 
17  The Column Plane is the plane of maximum slope. 
18  Geographical (absolute) North-South Direction. 
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the bedrock is considered as Deformable19 then it is 
assumed to be an isotropic and homogeneous linear 
elastic material. 

In the Control Point Frame the input motion is assumed to 
be given at the surface of the multilayer (non)linear 
viscoelastic rock. 

 

 

The multilayer
rock on which
the input motion
is given

 

 

Control Point Tools menu 
See the Tools menu in the Main Frame (Chapter 2). 

Control Point Deconvolution menu 
The following operation may be performed by using this 
menu. 
                                                 

 
19 A deformable bedrock is modeled as a semi-infinite isotropic 

homogeneous elastic linear medium. It is characterized by the shear 
and compression body wave velocities and its mass density. 
When the bedrock is selected as deformable it is check-marked in 
the menu. To disable this option select this option a second time. 
The check-mark disappears to inform the user. 
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Checklist 
This command lists the data required for starting the 
computation. 

Start Deconvolution 

Use this command to start the Deconvolution of the Input 
Motion from the Control Point. 

The command is enabled only if all data20 needed for a 
computation have been furnished. 

Control Point Results menu 
See the Results menu in the Equivalent-Linear Frame 

(Chapter 5). 

Control Point Window menu 
See the Window menu in the Equivalent-Linear Frame 

(Chapter 5). 

                                                 

 
20 The data needed for a computation are: 

1- Thickness, Vs, Vp and ρ, for all layers 
2- (G-γ), (D-γ) Curves for all layers, except the Bedrock or 

Outcropping Bedrock 
3- An Input Motion 
4- The Time History 
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Control Point Help menu 
See the Help menu in the Equivalent-Linear Frame 

(Chapter 5). 
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Chapter 6: Theoretical Background 

Two kinds of direct and one inverse analysis may be 
performed by CyberQuake: 

1. Cyber Analysis (transient analysis). 

2. Equivalent Linear Analysis. 

3. Deconvolution. 

In 1, soil layers may be considered as elastoplastic 
materials (with isotropic linear elasticity as a special case). 
True transient nonlinear analyses are carried out and, 
following the version, two or three-dimensional kinematics 
are assumed. 

In 2 and 3, soil layers are treated by Equivalent Linear 
assumption and viscoelastic analyses are performed while 
the dependence of the shear modulus, as well as the 
damping, on distortion is incorporated. The computations 
are done in the frequency domain. It is also possible to 
perform direct linear (visco)elastic analyses in 2 and 
deconvolution in 3. 
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Cyber Dynamic Model 
 

Governing equations for one-dimensional two-phase 
media 
The dynamic equations of the model without body forces 
while neglecting the pore water compressibility in a 
reference (0-xyz) are given as: 
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with: 

σ' = σ + p  The effective normal stress 

τ   The shear stress in the soil layer 
plane 

P   The pore pressure 

A = a + az ez  The absolute acceleration vector 

vz   The normal velocity component 

k    The isotropic permeability 
coefficient 

ρ = (1 - n) ρs + n ρw The overall mass density 

n    The porosity 

ρs   The mass density of solid 
component 

ρw   The mass density of fluid 
component 
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Boundary conditions 
The boundary conditions are defined by current 
engineering language (e.g. water table position, 
deformable/rigid bedrock, etc.) instead of using numerical 
modeling terminology. Therefore, standard boundary 
conditions are easily prescribed on the boundaries. 

The rigid bedrock assumption simplifies computational 
aspects, as no absorbing boundaries have to be taken into 
account. With this assumption, the calculation can be done 
in a moving reference frame that results in a fixed base. 
The seismic loading is modeled as a prescribed 
displacement time history of the rigid bedrock, which 
results from the double integration of the input acceleration 
with respect to time. 

In this case the soil profile may represent a slope as shown 
in the figure below. 

 

α

X

Z

Y

ux

uz

uy

x

z

y

 
Schematic presentation of the model with rigid bedrock 

 

Due to the symmetry of the geometry, initial state and 
loading history, the problem appears to be purely one-
dimensional, e.g. all points at a given depth have the same 
displacement, pore pressure, stress and strain histories. 
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Here, the displacement vector may be decomposed into 
two vectors: the sliding, along the slope direction, and the 
displacement normal to the slope surface. The related 
strain reduces to the shear strain vector and the normal 
strain. The related stress is characterized by the shear 
stress vector and the normal stress. 

For deformable bedrock, absorbing boundaries are 
introduced. For transient analyses, it is possible to develop 
frequency independent local absorbing boundaries with 
respect to time and space. 

The weak formulation of the governing equation is given 
as: 
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pu Γ∪Γ=Γ∪Γ=Ω ϕσ∂  is the boundary of the studied 
domain Ω . 
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σΓ  and  (respectivelyuΓ ϕΓ and ) represent the part of 
the boundary where stress and displacement (respectively 
flux and pore pressure) are prescribed. 

pΓ

)( zettT += and ϕ  are respectively the prescribed stress 
vector and flux on the boundary. 

The interface between the modeled and underlying (semi-
infinite) domain designated by Σ in the next paragraphs, 
may belong to either Γσ or Γu (respectively Γϕ or Γp) 
depending on the assumption on the rigidity of the bedrock. 
If a water table is considered, we always assume that the 
bedrock is impervious. Therefore, no flux occurs across the 
interface boundary and the integral over Σ in the third 
equation is always zero. 

The above formulation is then considered with finite-
dimensional approximations for Π,,ϑδ and Θ as 

and and identified in an abstract form as: hhh Π,,ϑδ hΘ
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Rigid Bedrock 
For a rigid bedrock, the motion at the base is prescribed. 
Hence, the prescribed displacement time history is 
considered on the RHS of the equation system and the 
integral over Σ vanishes. The weak formulation for finite-
dimensional spaces may be written as: 
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where: 
hhh UVU +=  and  hV h ϑ  ∈  

so that  the boundary condition: 
hh UU = over Σ  

is satisfied (in the finite element sense). 

Deformable Bedrock 
As noted before, we assume that the bedrock is totally 
undrained, thus only the stress vector over Σ has to be 
evaluated. Here, this vector represents the transient 
impedance (action) imposed by the outer (semi-infinite) 
domain on the studied domain. Thus, the weak formulation 
becomes: 
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Assuming an isotropic linear elastic behavior at the vicinity 
of the boundary Σ, we will split the total displacement 
vector into the incident and radiant (or diffracted) 
displacement fields: 

E
r

E
i

E UUU +=  

where superscript E designates the exterior domain. 

Moreover, the displacement field must satisfy the 
Sommerfeld radiation condition: 

E
i

E UxU =)(  when  ∞→x  

and the free field incident motion must be compatible with 
the free surface conditions. 

Now, we will  write the radiant field through the outer 
domain due to the diffraction over Σ. The continuity 
condition for the stress vector over Σ and the linearity 
hypotheses at its vicinity enables us to write, for one-
dimensional geometry and vertically incident waves: 
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The two last terms in RHS of the above equation are 
unknown. The weak formulation becomes: 
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Note: The above formulation is general and may be 
degenerated to simpler ones depending on the draining 
condition. For totally drained condition, the pore-pressure 
is not to be considered in the formulation and the hydraulic 
equation disappears. In the case of the totally undrained 
formulation, the permeability coefficient is assumed to be 
zero. Therefore, an incompressibility condition presents. To 
deal with such a case, and to avoid numerical difficulties, 
the total stress is evaluated from the first equation and the 
pore-pressure is calculated as the difference between the 
effective and total normal stress. The incompressibility 
equation, representing the impervious soil layer, is 
introduced directly in the constitutive model. This 
methodology is presented hereafter. Totally undrained 
case at point z: 
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with: 
ε p  The plastic strain 
H The depth of the layer 

The final pore-pressure, when the seismic input motion is 
at rest is thus given by: 

),(),( TzKTzp ph ε−=  

Although there is no dynamic settlement in this model a 
permanent static settlement will occur after the end of the 
seismic event (t>T) from the distribution of pore pressure 
under quasi static conditions. In the case of partially 
undrained condition, the whole system of equations is 
resolved. 
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Time-Space discretization 
The equations are discretized with respect to the z variable 
by finite elements, and numerically integrated with respect 
to time by an explicit Newmark scheme. The time step is 
computed with respect to stability and precision 
requirements of the integration scheme. 

The velocity in the solid skeleton and pore water pressure 
(for two-phase computations) are considered as main 
unknowns. In that case, higher order approximations are 
used for velocities compared with the pore-pressure (i.e. 
v3p2 elements). 

The mass matrix for the quadratic element is diagonalized 
using the following procedure. The base functions are 
transformed using two additional parameters α' and β' as: 
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The consistent mass matrix is computed using these new 
base functions. The adding parameters are calculated so 
that the off-diagonal terms vanish, thus new base functions 
are obtained. 
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Cyber Constitutive Model 
A linear elasticity is assumed here. With σ  the vertical 
effective stress and τ  the shear effective stress vector, the 
elastic strain rate is then given by: 
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where  and  are velocities for compression and shear 
waves and 

pc sc
ρ  is the overall specific mass of the solid 

skeleton: 

ρ
µλ 2+

=pc   and 
ρ
µ

=sc  

wws Snn ρρρ +−= )1(  with n the porosity and  the 
degree of saturation (=1 for saturated materials, =0 totally 
dry material). 

wS

Then the deviatoric yield surface is proposed as: 
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The function  is introduced to take into account the 
volumetric hardening or softening with respect to the 
critical state of the material as: 

F
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with b a numerical parameter ( 10 ≤≤ b ), β  the plastic 
compressibility modulus and ciσ  the critical state pressure 
for the initial state. 

Subscript 0 indicates the value of the variables at 
unloading/reloading. 

The internal variable r  (also called the degree of 
mobilized friction) introduces the effect of shear hardening 
of the soil. 

It also permits the decomposition of the behavior domain 
into elastic, hysteretic and mobilized domains introduced 
by other model parameters called  and . It is 
given as: 
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with φtan=mr  (φ  being the friction angle at the critical 
state),  the current time,  the time of the last change in 
the loading direction with its associated degree of 
mobilization , 

t 0t

0r
pγ&  is the norm of shear plastic strain rate 

and finally  and are model parameters governing the 
evolution of the yield surface towards the total plastic 
mobilization. 

rn pE

The plastic flow rule is defined as: 
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The direction of plastic flow is obtained by assuming the 
normality rule for the deviatoric component and Roscoe's 
dilatancy rule is assumed for vertical plastic strain: 
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where ψ  is the dilatancy angle corresponding to the 
characteristic line. 

ς  is function of r as: 
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Note: 
1. αψ is a constant parameter introduced only to permit 
users to prevent any plastic contractance or dilatancy by 
putting it equal to zero. The plastic multiplier λ&  is 
evaluated from the persistency (or consistency) condition; 
i.e. , after introducing the evolution law for the 
internal variable 

0=f&&λ
r  from its dependency upon the shear 

plastic strain rate pγ& . 

Note that with the definition of dΨ , we have pγλ && =

2. In the definition of the flow rule, ψ appears instead of φ . 
The former is known as the characteristic angle and the 
later as the friction angle at the critical state. The difference 
between the characteristic and critical state is a much 
debated question. The later describes the perfect plasticity 
state while the former represents the transition from the 
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contracting to the dilating behavior under compression. 
The discussion about this topic is out of the scope of this 
paper. By choosing the same value for φ  and ψ , the 
standard critical state approach may be recovered. 
 

Constitutive Model Parameters 
Besides elastic mechanical properties given by P and S 
wave velocities and the bulk density in a Soil Layer, other 
model parameters are necessary for nonlinear modeling. 

These parameters are defined in the brief representation of 
the Cyber Constitutive Model given above. 

To facilitate the work with the software, some soils have 
been already defined and their model parameters are 
furnished. However, the model's response may not be 
satisfactory. For instance, the G/D-γ curves do not match 
experimental results. Therefore, it will be necessary to 
calibrate the model parameters. This may be done by 
using Simulator command of the Plastic Model drop-down 
menu of Define menu command in Soil Column Frame. 

The parameters have been classified in two categories. 

The users are advised to start with modifying basic 
parameters. 

The use of specified parameters requires a deeper 
knowledge of the constitutive model used here. 
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Basic parameters 
These parameters may be considered as more influential 
in the simulation of the soil behavior. 

ϕ Friction angle at totally mobilized plasticity (the 
slope of the Critical State Line) 

Ερ Plastic stiffness (a hardening parameter 
affecting the initial plastic slope) 

σci/σv Compaction ratio (a parameter representing the 
compaction state of the soil) 

β Plastic modulus (a parameter for isotropic 
hardening due to compaction) 

C Cohesion 

Note: Ep influences the initial slope of (G/Gmax-γ) curve, 
while σci/σv affects its residual value for large strain. 
Smaller values for σci/σv results in a looser soil. In drained 
conditions a loose soil densifies (settles down) and in 
undrained conditions it may liquefy. 
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Specific Parameters 
These parameters permit a finer calibration of the model 
response: 

b Numerical parameter affecting the shape of the 
yield surface (1: Cam-Clay type, 0: Coulomb 
type) 

nr Numerical parameter affecting the isotropic 
hardening due to shearing (default : 0.5) 

γela Parameter representing the extent of the truly 
elastic domain 

γhys Parameter representing the extent of the 
hysteretic domain 

γmob Parameter representing the extent of the 
mobilized domain 

ψ The slope of the characteristic line (default: 
ψ=ϕ) 

αψ A parameter affecting the magnitude of the 
dilatancy (default : 1.0) 

Note:  
1. Small values are in general recommended for b in the 
case of sands (0-0.2) and large values for clays (0.8-1.0). 
2.  Small values for nr results in stiffer G/Gmax-γ  curves. 
3.  γhys and γmob may be used for a finer calibration of the 

liquefaction onset. 
4.  αψ = 0 results in zero dilatancy (or zero contractance). 

Liquefaction 
The liquefaction is a physical phenomenon that may occur 
generally in loose sands or silty soils under undrained 
conditions. In this software we are concerned with 
liquefaction due to cyclic loading (in opposition to static 
liquefaction). 

The almost incompressibility of the saturated soil in 
undrained conditions and the contracting tendency in loose 
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materials are the essential factors for liquefying a soil 
subjected to deviatoric cyclic loading. 

When the mean effective pressure vanishes due to the 
pore-pressure generation the soil is no more able to 
sustain any shear resistance and behaves almost like a 
viscous (non)newtonian fluid. 

In situ, observations sometimes show a strength recovery 
in liquefied soils. In fact, the pore pressure may dissipate 
after a while either due to its infiltration to neighboring 
zones or the large dilatation of the soil. The shear strength 
recovery after liquefaction is not included in this version of 
the software, as in engineering practice a liquefiable soil 
may be improved by appropriate techniques and it is not 
recommended to include a possible shear strength 
recovery in designs. 

 

Equivalent Linear Model 
The Equivalent Linear approach is performed assuming a 
system of homogeneous, multilayer, laterally infinite 
viscoelastic layers subjected to vertically incident shear 
and compression body waves (only out-of-plane shear 
waves in Engineering Analysis version). 

The complex transfer functions computed for each layer 
depend on the complex wave velocities and the mass 
density of each layer. 

The damping is assumed to be frequency independent and 
represents the plastic dissipation. This assumption is 
generally admitted for sands but may be questionable for 
clayey materials in which the presence of adsorbed water 
may induce some frequency-dependent viscosity. 

In the Advanced Engineering version, where two horizontal 
components of motion are taken into account, we assume 
that the apparent shear modulus varies with the  
L2-norm of the shear strain vector in the plane of the soil 
layer. Hence, it is assumed that the shear resistance 
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reduces in all directions in an isotropic way and constitutes 
a strong hypothesis. However, in the seismic context it may 
be admitted that an averaging may be statistically realized. 

The complex compression wave velocity is assumed to be 
constant and does not depend on distortion. This 
assumption is physically realistic. 

As the apparent shear modulus and associated damping 
ratio vary with distortion, an iterative scheme is used. 

The following flow-chart shows different steps of 
calculations: 

1- G = Gmax, D = Dmin, Vp = λ
ρ

+ 2G (1 + 2iD )p  

2- Compute the Fourier transform of the input motion 

3- G* = Gk(1 + 2iD), Vs = 
G *
ρ

 

4- Compute the transfer functions 
5- Convoluate the Input Motion with the transfer 

functions 
6- Compute γ in the middle of each layer 
7- Inverse Fourier transform of γ to obtain γ(t) 
8- Compute the norm of the shear strain vector || γ(t)|| L2 
9- Compute γ = χ Max(|| γ(t)||L2) 
10- Evaluate Gk+1(γ) and Dk+1(γ)  

11-  Go to 3 if  G G
G

k+1 k

k
− > θ% and if k < κ 

12- Evaluate the acceleration, velocity and displacement 
vectors at the top of each layer 

13- Evaluate the stress and strain vectors in the middle 
of each layer 
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In 3, it is possible to use: 
either the equation proposed by Schnabel:  

G* = G(1 + 2iD) 

or the equation proposed by Lysmer: 

G* = G(1 - 2D2 + 2iD 1− D2 ) 

In general, less than κ = 10 iterations are necessary for the 
algorithm to converge and θ = 5% is used in practice. 
Moreover, the value of χ = 0.65 in 9, is very often adopted 
following recommendations from users of the program 
SHAKE, in which this approach has been introduced 
originally by Schnabel et al. (1972)21 for out-of-plane 
vertically incident shear waves. The following equation may 
be also used to estimate χ: 

χ = M − 1
10

 

in which M is the magnitude of the earthquake. 

In CyberQuake, it is also possible to assume a rigid 
bedrock. For this purpose and in order to avoid unrealistic 
results due to the cut-off of the signal in the computing 
window, the following steps are added to the above 
algorithm: 

2bis- Multiply the Fourier transform of the Input 
Motion by e-αt

4-  Compute the transfer functions using the 
complex frequency * iω ω α= −  

The other steps are identical. 

                                                 

 
21  Schnabel B., Lysmer J; and Seed H.B, SHAKE : A Computer 

Program for Earthquake 
Response Analysis of Horizontally Layered Sites, Report N°. EERC 
72-12, UC-Berkeley, 1972. 
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The parameter α is not directly introduced in the program. 
It is included by a the numerical coefficient c given as: 

1c
initialtendt

clog
≥

−
=α  

The default value for c is 5. To suppress the effect of α, c 
should be taken equal to unity. This parameter may be 
accessed by selecting Parameters in the dialog box of 
Time History from Define drop-down menu command in 
Equivalent Linear Frame or Control Point Frame 

 

Control Point and Deconvolution 
In general, the control point is where the Input Motion is 
defined. 

In CyberQuake, when using the Soil Column Frame or the 
Equivalent Linear Frame, the Input Motion is assumed to 
be located at the outcropping bedrock at the same  altitude 
as the underlying bedrock. 

However, by using a Control Point Frame, it is always 
possible to assume an outcropping multilayer rock having 
its own geometry on which the Input Motion is defined. The 
behavior of this multilayer structure is assumed to be 
viscoelastic, but also nonlinear, as the elastic moduli and 
damping may vary with the level of shear strain. 

The prescribed accelerogram is introduced via the Input 
Motion, assumed to be defined on the surface of the 
multilayer rock and deconvoluated to the outcropping 
bedrock assuming an Equivalent Linear type approximation 
for the rock. 
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The control point
where the input motion
is defined

Deconvolution of the
input motion to the
outcropping bedrock

The bedrock common
to the soil column and
multilayer rock

The soil column used
for Cyber or Equivalent
Linear Analysis

The outcropping bedrock to
where the input motion is
deconvoluated from the
control point and where the
input motion is defined for
the soil column analysis

The bedrock common to the
soil column and multilayer
rock

 

 

To combine a deconvolution analysis with a direct 
computation of a Soil Column, one should first 
deconvoluate the motion from the Control Point to the 
outcropping rock as shown in the above figure, and then 
use the Results command in the Control Point Frame to 
visualize and save the computed acceleration components 
at the outcropping bedrock. Then, these acceleration 
components may be used as Input Motion for either a 
Cyber Analysis or Equivalent Linear Computation. 
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menu,56 
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Tools menu commands,17 
Top Load Components,48 
Total Strain,53 
Tsang Signal,20 
Two-phase,48 

U 
Unit Conversion,37 

V 
Velocity,52 

W 
Water Table Depth,47 
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